
COILED-TUBING 

DRAG MODEL 
Version 1.0 

User 's Manual 

BY 
MAURER ENGINEERING INC. 
2916 West T.C. Jester Boulevard 

Houston. TX 77018-7098 

Telephone: 7131683-8227 
Facsimile: 7131683-6418 

http://www.maureng.com 

November 1997 
TR97-26 

This copyrighted 1997 confidential manual and computer program are for the sole use of Participants on the 
Dr i l l i ng  Engineering Association DEA-67 project to Develop and Evaluate Coiled-Tubing andslim-Hole 
Technology and their affiliates, and are not to be disclosed to th i rd parties. Data output from the program 
may be disclosed to third parties. Participants and their alfiliates are free to make copies o f  this manual and 
program for  their in-house use only. 





Table of Contents 

Page 

1 . INTRODUCTION . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-1 
1 .1  BACKGROUND . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-1 
1.2 FEATURES OF CTDRAG 1.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-1  

1.3 COPYRIGHT AND DISCLAIMER . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-3 

2 . GETTINGSTARTED . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-1 

2.1 HARDWARE AND SYSTEM REQUIREMENTS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-1 
2.2 INSTALLING CTDRAG . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-1 
2.3 RUNNINGCTDRAG . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-2 
2.4 QUICK TOUR OF CTDRAG 1.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-2 

3 . INPUT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-1 
3.1 REQUIREDINPUTDATA . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-1 

3.2 INPUTWINDOWS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-2 
3.2.1 Modelpage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-2 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3.2.2 Projectpage 3-4 
3.2.3 Surveypage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-4 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  EnteringJEditing the Survey Data 3-5 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  TortuosityWindow 3-7 

3.2.4 TubularsPage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-9 
3.2.5 Drag Parameters Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-10 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3.2.6 Input Window Menus 3-11 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  FileMenu 3-11 

RunMenu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-12 
OutputMenu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-12 
Utility Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-12 
HelpMenu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-14 

3.3 ERROR DETECTION FOR INPUT DATA . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-14 

4 . OUTPUT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-1 
4.1 INTRODUCTION . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-1 
4.2 OUTPUTWINDOW . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-1 

4.2.1 Main Output Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-1 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4.2.2 Sensitivity Analysis Window 4-3 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4.2.3 Operation Animation Window 4-5 

4.2.4 Output Window Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-6 

FileMenu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-6 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  PrinterMenu 4-7 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  WindowMenu 4-7 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  HelpMenu 4-8 

4.3 MTERPRETING OUTPUT DATA . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-8 

5 . GETTINGHELP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-1 
5.1 CONTACTINGMEI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-1 
5.2 REPORTING PROBLEMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-1 

APPENDIX A . 4  OMMON PROBLEMS AND SOLUTIONS 

... 
111 0 1997 Maurer Engineering Inc . 



O 1997 Maurer Engineering Inc. 



1. Introduction 

1.1 BACKGROUND 

CTDRAG was developed by Maurer Engineering Inc. under sponsorship of the joint-industry project DEA-67 
To Develop and Evaluate Coiled-Tubing and Slim-Hole Technology. This model is part of a complete coiled- 
tubing analysis suite, and will be incorporated into the integrated package CTPRO in the future. CTDRAG 
replaces the DOS-based CDRAG developed previously under DEA-67 and DEA-44 sponsorship. Many new 
features and capabilities have been incorporated into this advanced drag model. CTDRAG runs in the 
Windows environment on IBM-compatible computers with Microsoft Windows 3.x, 95 or later versions. 

CTDRAG analyzes the complex phenomena of axial loads and the development of drag (and buckling) of 
coiled tubing as it is 1) run into the hole (slack off) or 2) pulled out of the hole (pick up). Since coiled tubing 
is not rotated, CTDRAG does not model torque. For compressive loads, the onset of 1) sinusoidal buckling 
(with a choice of three models), 2) helical buckling (with a choice of three models), and 3) pipe yielding are 
indicated. 

Two types of axial load plots are generated: 

1. Axial load vs. measured depth along the string of coiled tubing at a specific time (that is, a snapshot 
when the BHA is at the bottom of the hole) 

2. Surface load history vs. measured depth of the BHA during slack-off and pick-up operations 

All input data for the program is contained in a single project file. This file is also compatible with .SDI files 
(survey data input) generated by other ME1 software. Survey data can be modified by the Tortuosity option, 
and distributed tortuosity can then be added to the survey to simulate field conditions. 

1.2 FEATURES OF CTDRAG 1.0 
- 

CTDRAG 1.0 is a major release in the suite of coiled-tubing software developed by MEI. Three types of 
coiled-tubing operations are modeled: logging, drilling, and packer operation (that is, generating pushlpull 
forces downhole). Among the features are advanced buckling and drag calculations along with sensitivity 
analyses of each critical parameter. A special animation window displays the axial load distribution and 
buckling status as the coiled tubing is hipped in. A method to account for the impact of residual bending on 
coiled-tubing drag is included. 

The "look and feel" of the program is very user-friendly and intuitive. CTDRAG runs in the Windows 
environment, and intuitive tabs and icons can be used to quickly navigate through the program. Input data-file 
management is improved, and a variety of options for customizing graphics and producing professional-style 
printouts are included. 

Another significant feature is a complete Help system. Descriptions and instructions are provided for every 
input and output screen. The Help system is also context sensitive to allow intuitive navigation by pointing 
and clicking the mouse on the area of the screen where the user's question originates. 

0 1997 Maurer Engineering Inc. 



Chapter 1. Introduction 

Important technical features of the CTDRAG Coiled-Tubing Drag Model include: 

Handles up to eight different hole sizes and friction factors. 

Calculates both the tubing load below the stuffing box and the hook load. 

Calculates the hydraulic force caused by wellhead pressure. 

Accounts for the impact on slack-off drag of residual bending in the coiled-tubing string. 

Accounts for the weight of internal wireline. 

Wellbore survey data may be "tortured" (have doglegs added), so that the survey is more realistic than 
the ideal smooth trajectory resulting from well planning. The wellbore may be divided into up to five 

zones. with each zone given a different distributed tortuosity. 

Coiled-tubing data may be imported from a large database included with the program. Data on other 
tubulars may also be imported to describe the wellbore casing and production tubing. 

A sensitivity analysis allows the user to evaluate the impact of friction factor, BHA drag, wellhead 

pressure and WOB on drag for coiled-tubing drilling and logging operations. 

Provides a choice of systems of units, including English, S1 (metric), or any user-specified custom 
combination. 

The Output Window provides a number of informative graphs and text reports including: 

1. Axial Load Distribution (Slack 08. This is a snapshot of loads across the string when the BHA is at 

the bottom of the well and slack-off (push) loads are being applied. Buckling condition is easily 
visualized by noting sections of the string where the axial load crosses over limit curves. 

2. Axial Load Disrriburion (Pick Up). This is a snapshot of loads across the string when the BHA is at 
the bottom of the well and pick-up (pull) loads are being applied. (Buckling cannot occur when the 

string is in tension.) 

3. Normal Force Distribution. Normal forces (the components of compression, tension andlor gravity 

forces that push the string against the side of the wellbore) are plotted as a snapshot when the BHA 
is at the bottom of the well. Traces for both slack off and pick up are plotted together. 

4.  Surface Load at Injector. This graph shows predicted pushipull loads at the bottom of the injector 

throughout the planned operation. 

5. lnclinarion andDoglegAngle. The wellbore survey is illustrated with plots of both inclination angle 

(degrees from vertical) and dogleg angle (local rate of change of inclination). 

6. Tabulated Results. All drag, buckling, force and survey results are summarized in a table. Columns 
include 1) measured depth, 2) inclination, 3) azimuth, 4) dogleg angle, 5) hook load (slack off), and 

6) hook load (pick up). 

All output data may be printed, copied to the Clipboard for export into other Windows applications, or stored 

to disk. 
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,/- - 1.3 COPYRIGHT AND DISCLAIMER 

This software and manual are copyrighted (01997) by Maurer Engineering Incorporated. The copyright 
agreement and usage restrictions are described on the screen that immediately foIlows the opening title screen 

(see below). By selecting OK at  the bo t tom o f  this screen, the user signifies t ha t  he agrees t o  abide by 
the restrictions as presented. No warranty or representation, either express or implied, is given with respect 

to this program and documentation, including their quality, performance. merchantability, or fitness for a 

particular purpose. 

CTDRAG 1.0 

Coiled-Tubing Drag Model 1 
DEA-67 

Projecito Develop and Evaluate 
Coiled-Tubing and Slim-Hole Technology 

BY 
Maurer Engineering Inc. 

This copyrighted 1997 confidential computer program and manual are for the sole 
use of Partlcipanls on Drilllng Englneerlng Association R o j e d  DEA-67 and thelr 
aliiliates, and are not to be disclosed to othcr parties. Data output from the 
program may be disclosed to thlrd parties. Parllcipants and thelr anlllates are 
free to make copies ol this program and manual for their in-house use only. 

Maurer Engineering Inc. makes no warranty or representation, either express 
or Implied. with resped to the program or documentation, Including their quality. 
performance. merchantability, or fitness for a pattlcular purpose. 

International keyboard users - see AppendixA of User's Manual. 
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2. Getting Started 

2.1 HARDWARE AND SYSTEM REQUIREMENTS 

CTDRAG is written in Microsoft Visual Basic@. It runs in either the standard or enhanced mode of Microsoft 
Windows 3.x or 95. The minimum hardware requirements are: 

1BM-compatible machine with 80386 processor 
Hard disk (about 3 megabytes of storage space required) 

Mouse 
VGA or compatible display 

2.2 INSTALLING CTDRAG 

Program Disks 

CTDRAG is shipped on three 3%-inch disks containing multiple files. We strongly recommend that all Visual 
Basic library files be stored in the CTDRAG subdirectory. This will avoid potential conflicts with other 
software based on earlier (or later) versions of the same Visual Basic library files (see Appendix A for a 

complete discussion). The CTDRAG executable file (CTDRAG1.EXE) should also be placed in the folder 
(default "C:\CTDRAGln, or as specified by the user) along with the example data file Cdtest.cd1. All of these 
procedures will be accomplished during the set-up procedure described below. 

Backup Disks 

It is recommended that the original disks be kept as a backup set and stored in a safe location, and that work 
disks be made from them. A copy of the original disks can be made using the COPY or DISKCOPY command 
in DOS, or "Copy Diskette" on the disk menu in the File Manager in Windows 3. ln Windows 95, run 
Windows Explorer, double-click "My Computer", single-click the icon for your floppy dnve, and select "Copy 

Disk" from the File menu. 

Installation 

The following procedure will install CTDRAG from the floppy drive onto the working directory of the hard 
disk (e.g., copy from A: floppy drive onto hard drive directory C:\CTDRAGI). 

1. In Windows 3.x, open the Program Manager and choose Run from the File menu. Then type 
"A:SETUP." In Windows 95, choose Run... from the Start menu. Then type "A:SETUP." 

2. Follow the on-screen instructions 

rn After set up, there will be a new Program Group in Windows 3.x containing the application. A new folder can 
be created in Windows 95 to hold CTDRAG and other ME1 Applications icons. Refer to Windows 95 

/C4. references for help with creating or editing folders. 
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Chapter 2. Getting Started 

2.3 RUNNING CTDRAG 

In Windows 3.1, start CTDRAG from the ME1 Applications Window. Double-click the "CTDRAG" icon, or 
when the icon is focused, press <ENTER>. 

In Windows 95, select CTDRAG under the ME1 Applications from the Program Menu. 

The design and operation of the input screens in CTDRAG are described in Chapter 3. Output screens and 

features are discussed in Chapter 4. For assistance with the program, contact ME1 using information presented 
in Chapter 5. Common problems and solutions are described in Appendix A. 

2.4 QUICK TOUR OF CTDRAG 1.0 

The following quick tour will give the new user a rapid overview of the basic structure and features of 

CTDRAG. 

Install: 

1. Start Windows (3.1 or later version). 

2. Insert CTDRAG Disk 1 in drive A: 

3. Windows 3.x: choose Run from the File menu under Program Manager. Windows 95: choose Run ... 
from the Start Menu. 

4. Type A:SETUP and press Enter. Follow the on-screen instructions. 
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Chapter 2. Getting Started 
r - Run: 

5. Launch CTDRAG. Double-click the CTDRAG icon (Windows 3.x), or select CTDRAG from the 

Programs list under the Start  menu (Windows 95). 

6. Click OK in the Introductory Window to accept the terms and conditions of the program license. 

Input: 

7. In the Main Window, choose "Open File ..." from the File menu. 

8. From the "Project File Open" dialog box, click the drive C: in the drive list box, double-click the 

"CTDRAGI" subdirectory (or the directory specified during set-up), click "Cdtest.cd1" in the file list 

box, and click OK. (Please note that parametric values in the example projectfile are for illustration 
only and should not be considered aspreferred values.) 

9. Click each of the input window tabs (Model, Project, Survey, Tubulars, and Drag Parameters) to view 

each page of input data. 
1 7 q -  

10. Select "Start" from the Bun menu (or click the runner icon ). The progress of the calculation will 
be displayed at the bottom of the Model screen. 

- - Output: 

I 1. After the Output Window is opened, select text reports or graph windows of interest to enlarge for viewing 

in more detail. Click on a] to zoom a graph to full screen and then 6 to replace the graph Into the 4 
tiled windows. ~ouble-clzanywhere  on the Graphs or Table to toggle between the full screen and tiled 

views. 

12. To print the summary text report, click on the Tabulated Results window to make it active (its title bar 

background will turn blue) and select "Print Table" from the File menu. 

13. To print a copy of any active graph window, select "PrintlGraph" from the File menu. 

14. Choose "Return" from the File menu to return to the input windows and then click "Exit" from the File 

menu to close the program. 
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3. Input 

3.1 REQUIRED INPUT DATA 

Data management is very simple in CTDRAG. The filing system design in the previous program CDRAG 3 
included separate files for each type of data (.WDI, .SDI, .TDI. etc.). This earlier storage design has been 

replaced by a single file (with extension .cdl) that stores all identification, survey, and parametric data. 
Wellbore survey data files used by other ME1 software (in *.SDI files) can be imported into and exported fiom 

the program. Input data required to run CTDRAG are listed below. 

Well Information: 

1. Well and project description (company name, project name, well location, etc.) (optional) 

Survey Data: 

2. Directional survey data for the well, including survey station depths, inclinations and azimuths 
.-. 

Tubular Data: - 
f l  3.  Description of coiled-tubing string, including OD, wall thickness, weight per unit length, whether the wall 

thickness is tapered, length, yield strength and Young's modulus. If the string is tapered, these data are - required for each section. 

4. Length, weight, ID, OD, and drag of BHA (logging or drilling) 

5. Weight on bottom (drilling or packer operation) 

Drag Parameters: 

6 .  Depth, ID, and friction factor for each section of the wellbore 

7. Additional friction factor to account for residual bending 

8. Fluid densities 

9. Wellhead pressure and stuffing-box drag 

10. OD and weight of wireline cable inside the coiled-tubing string 

1 I .  Safety factor for applying to coiled-tubing yield load 

12. Pulling capacity of coiled-tubing injector - 
Data can be entered and displayed in English or metric units, or in a custom combination of units defined by 

the user. All input data saved on disk or in memory are in the English system of units 
I -  
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Chapter 3. Input 

3.2 INPUT WINDOWS 

In the Main Project Window of CTDRAG, there are five different pages for organizing input data. Each is 
accessed by clicking on its tab below the icon tool bar. Functions and parameters on each screen are described 
in the sections which follow. 

3.2.1 Model Page 

The Model Page is the initial navigation point for controlling CTDRAG. 

@ Menu Bar. The function of the pull-down menus in CTDRAG is similar to that in other Windows 

applications. A description of all functions and features is presented later in this chapter in Section 3.2.6. 

@ Tool Bar. Tool bar icons can be used to quickly access commonly used functions. The icons are short- 

cuts for menu options. The functions of the icons are: 

New Project. Clears all input data. 

Open File. Activates the open file window. 

Save. Saves all Input data to the current file name. if the project is new, will automatically 
actlvate the Save As. . w~ndow. 

Prmt. Activates the prlnt options window. 

a C A L M  Activates the ME1 GALAXY database window for importing/exporting data and 
results to other software. 

O 1997 Maurer Engineering Inc. 



Chapter 3. Input 

Run Initiates calculations. Progress can be monitored on the Status Bar. 

Output Goes to output screens without recalculating. Not active if calculation has not yet been 
performed. 

(lnlts. Opens the Units Selection window. The user can select English, SI, or any custom 

combination of units. 

Help. Opens the Help system for CTDRAG. 

Calculator. Causes the Windows utility calculator to pop up. 

@ Page Tabs. Switching between the five input screens for entering or checking data is simple-just click 
3. . -. , 

on the corresponding tab. The small circle on the left side of each tab :@; 1s like a traffic signal. A red , ,. ,,*, 

light indicates that data entry is not complete on that page. A green light on all tabs means that all required 

data have been entered and that the calculation sequence may be launched. 

Note that the tab color will not change until the page is redrawn (by selecting a different tab). 

@ Operation Options. One of three basic coiled-tubing operations can be selected, including logging, 

drilling and operating a packer. Labels on input and output screens are activated to reflect the specific 
operation selected. Operations other than these three listed can be modeled by selecting the option most 
similar. 

Select... for 

d Logging Operations without WOE (weight on bit) requirements 

d Drilling Operations with WOE required at a movingpoint downhole 

d Packer Operations with WOE required at a stationarypoint downhole 

@ Buckling Models. The user has a choice of three of the most respected models for defining sinusoidal 

and helical buckling criteria. A discussion on the differences in these models is presented in Section 4.3 

Interpreting Output Data. 

@ Project File. The project file currently in use is displayed here. CTDRAG files are automatically 

assigned the extension .edl . 

@ Calculation Status Bar. Afier the input data are entered, the calculation is launched by pulling down the 

run menu or clicking the run icon. Prior to beginning the calculations, the program automatically checks 
the data for errors (see Error Checking in Section 3.3). As the calculations are performed, the ongoing 
status is displayed in this bar with a percentage complete indicator. 
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Chapter 3. Input 

3.2.2 Project Page 

The Project Page is used solely for project documentation. These data provide specific information about the 
project to identify the company, project name, well location, date, and miscellaneous comments. Any (or all) 
of these items may be left blank if desired. The function of the program will not be affected. The maximum 
string length for each entry is 60 characters. 

3.2.3 Survey Page 
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Chapter 3. Input 

Survey describing the wellbore inclination and azimuth are required input. These data can be entered into 
CTDRAG 1) manually, 2) by pasting from an Excel spreadsheet (or other source), or 3) imported from an 

existing .SDI file created by another ME1 program. 

@ Survey Data ImporrZxport. Wellbore survey data in CTDRAG can be easily shared with other ME1 

software. The standard Survey Data Input file format (*.SDI file) is fully compatible. Data previously 

entered in other ME1 programs can be imported into CTDRAG. Data entered into CTDRAG can be stored 
separately for exporting into other programs. Note, however, that the CTDRAG project file (accessed 
under the File menu) which stores all input data (including the survey) is not compatible with other 

programs. Data sharing requires the additional step of creating an *.SDI file from this window. 

Use the a button to clear the survey data table (i.e . new file) The 1 button will open an existing 

.SDI file for importing into CTDRAG. will save the current survey data into the SDI format so that 

it can be imported into other ME1 software. Again, note that this save button is not needed unless these 
survey data are to be used elsewhere in other software. 

@ Survey Data Units Selection. The user can specify the format for entering survey data based on the 

format of the source data. If inclination is entered in Degrees:Minutes, the data may be entered using a 
decimal point to separate degrees and minutes. A colon will be entered automatically. 

@ Survey Data Table. Wellbore survey data are entered into the first three columns of the table. Column 

1 is Measured Depth of the survey point. Column 2 is Inclination Angle at that depth. Column 3 is 
Azimuth Angle at that depth. Column 4, TVD (true vertical depth), and column 5, DL (dogleg angle) are 
calculated quantities. The yellow background on these columns denotes they cannot be entered or edited 

by the user. 

The user may input up to 600 survey positions in the table. The survey depth in row I should be 0 feet 
(or 0 meters). Survey depths must be in increasing order (i.e., descending down the hole). The measured 
depth, inclination angle and azimuth angle each have two unit options, independent of the general system 
of units selected for the overall application. 

Enteringmditing the Survey Data 

To enter survey data, click on the appropriate box in the spreadsheet table. The most straightfonvard 
technique for data entry is to type the number and then press <Enter>. This will automatically shift the 
cursor position for the next entry. The order of entry when the <Enter> key is used is: 

[ROW I ]  MD, Inclination, Azimuth; [ROW 21 MD, Inclination, Azimuth; [ROW 31 ..... 

Moving Around 

When editing the data, the arrow keys are the easiest way to navigate within the table. The upldown arrow 
keys are used to move up or down within a single column. To movej?om column to column, use the arrow 

keys. Do not use the Tab Key; this will move the cursor out of the table to the next button. 
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After the arrow key or mouse is used to move to the cell of interest, the default edit mode for that cell is 

the overwrite edit mode. Type any number or a decimal point, and the old value will be erased and 
replaced by the new number. 

The number edit mode allows changing individual digits in the cell entry. This mode is activated by 
pressing <Escape> and then canceling the blue highlight on the cell by first using the right or left arrow. 
If the blue highlight is removed, single digits can be erased (using backspace or delete keys) and new 
digits added. 

Copying Data Into Tables 

Data can easily be copied into CTDRAG from other applicatrons (Excel, Lotus 123, etc.). This is 
especially convenient for survey data received from third parties (service companies). Open the data in 
Excel (etc.), arrange the data Into the required column layout (for example, 1) survey MD, 2) mcllnatron, 
3) azrmuth), select the data range, and copy to the Clipboard (press Control+C). To paste the data, open 

CTDRAG, place the cursor on the upper left cell ofthe target range, and paste from the Clipboard (press 
Control+ q. 

Note: set the system of units kd to the format of the survey data (feet or meters) before importing. 
After importing, the survey can be converted to the desired units 

Special RepeatICopy Feature 

A special feature is included in the Survey Data Table for copying the same value for inclination or 

azimuth into a range of cells. To copy a value, I) position the cursor over the source cell, 2) click and hold 
the right mouse button, 3) drag the cursor down the column to the last cell to be copied into, and 4) release 
the right mouse button. The copy feature will not function ifthe source cell is activated in the e d ~ t  mode 
by clicking on it with the left mouse button. Prior to copying, click the mouse on another cell not involved 
in the copy operation. 

The standard Windows key combinations can also be used to copy, paste or move individual entries. 

Control+C will copy the selected entry; Control+V will paste; Control+X will remove the entry to the 
Clipboard. 

@ Data Table Control Buttons. The table control [Insert Line] and [Delete Line] keys can be used for 

editing the survey table data. [Insert Line] will place a new blank row above the cursor position. 

[Delete Line] will clear the current row. A confmation pop-up box appears before any data are deleted. 

@ Dogleg Warning Feature. The dogleg warning feature was added at the request of our clients. If this 

feature is activated, the computer will beep when the dogleg severity exceeds the limit entered by the user 
in the box. This alarm can be used for indicating significant errors in inclination or azimuth data. Large 
errors (which produce large doglegs) will be quickly found and corrected. 

@ Survey Data Graph. The survey data are pIotted graphically in one of three formats chosen by the user. 

Options, which include inclination angle with depth, dogleg severity with depth, and a 2D wellbore 
profile, are selected by clicking the radio buttons at the bottom of the graph area. These plots can be very 
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helpful for spotting errors in the survey data. The selected graph can be sent to the printer by clicking 
[Print Graph]. 

@ Survey Colculote Button. When data entry is complete, the [Calculate] button must be pressed for 

calculating Columns 4 and 5 in the data table. These data will also be used to generate or refresh the 
survey graph on the right half of the screen. 

@ Tortuosity Button. The tortuosity button activates the Tortuosity Window (see below). 

Tortuosity Window 

When planning a well, surveys generated from geometric considerations (kick-off point, build rate, well-path 
shape, etc.) are usually smooth curves. Actual wells contain doglegs and other irregularities that increase drag. 
When ideal smooth curves are input into a drag model, the model predicts drag values that are lower than those 

in actual wells containing doglegs and other irregularities. 

Exxon developed a simple and elegant way to modify the survey data so that conditions are more representative 
of real wells. Tortuosity is added to the well path; that is, a small-scale sinusoidal variation with a given period 
(or cycle length) is added to both inclination and azimuth angles. 

The amplitude of the tortuosity (maximum value in degrees of the sine-wave variation) is chosen according 
to hole conditions. Erxon found that a tortuosiv of T = I "represents typicalJield conditions. The original 
survey data are then modified ("tortured") by adding the corresponding dogleg to each survey point. These 
data are exported to the Survey Page and used to predict drag and buckling in a non-ideal wellbore. 

@ Survey Doto Toble. The values initially appearing in this table are copied from the Survey Page. After 

tortuosity is added to inclination and azimuth, the adjusted values will appear in this table for review. Data 
cannot be edited w~thin this table Return to the Survey Page (cl~ck [OK] or [Cancel]) to make changes 
to any survey data. The table can be enlarged by using the Windows control buttons a and a 
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@ Tortuosiry Zone Parameters. The survey can be divided into as many as five zones (for example: surface 

to KOP, first build section, first tangent section, second build section, second tangent section...). Each 
survey zone may then be given a different amplitude andlor period for its distributed tortuosity. The 
bottom measured depth should always be equal to the maximum survey depth. 

Amplitude is the maximum dogleg added to the data. Exxon found that a tortuosity of T = 1 " represents 

typical field conditions. 

The Period is the length of one sine-wave cycle. This value is generally greater than the distance between 
survey data points. Note that, in selecting the tortuosity period, one potential problem needs to be 
avoided. If the untortured survey data are equally spaced and the tortuosity period A is assigned a value 

such that the measured depth of each survey station is n.A/2 (where n is any integer), then after calculation 
the survey data will remain untortured (the value of the tortuosity sine function will be zero exactly at 

every station). This means that the tortuosityperiod should not be assigned a value that is 2/n (2, I ,  +$ 
%, etc.) times the distance between survey stations. I t  is recommended that A be a t  least five times 
greater than the interval between survey stations. 

Inser t  Survey Stations is used if the survey depths are too widely spaced for a reasonable tortuosity 
period. Click "insert in zone x" to add stations. The default interval between inserted stations is 100 ft. 

@ Tortuosily Control Buttons. There are five command buttons at the bottom of the Tortuosity Window. 

[Calculate] tortures the original survey data, and both the survey data table and dogleg severity graph show 
the tortured survey [Undo] resets the data to the original survey. [Print] prints the actlve window. (If the 

table or graph is maximized on the screen and the print command button is hidden, press [F6] to pr~nt.) 
[OK] copies the tortured survey data to the Survey Page. [Cancel] closes the Tortuosity Window without 
any changes to the survey data. 

@ Tortured Dogleg Graph. The impact of adding tortuosity to the survey can be visualized by inspecting 

the dogleg graph. The graph may be enlarged for easier viewing by using the Windows control buttons 

and a 
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,- - 3.2.4 Tubular~ Page 

@ CT String Data Table. The geometry and properties of the coiled-tubing string are specified here. The 

element entered is the first row is the deepest section (that is, the outer end of the spool). Other tubing 
sections are entered proceeding toward the surface (toward the core of the spool). The cumulative length 

of coiled tubing is automatically calculated and displayed below the length column. Up to 20 tubing 
sections may be entered in the table. 

True-Taper is a tubing option available from the manufacturers whereby the change in wall thickness 
between sections of a tapered string is distributed evenly throughout that entire section of tubing. (This 

helps minimize stress concentrations at welds.) Elasticity is Young's modulus, which is a material 
constant (30,000,000 psi for steel; 18,000,000 psi for titanium). 

Techniques for entering and editing data in the table are summarized under Survey Page - O Survey Data 
Table in Section 3.2.3. 

@ Table Control Buons. The control buttons for the C T  String Data Table work only on complete rows 

of data. [Insert] places a new blank row above the cursor position. [Delete] clears data from one entire 
row, whether a single cell or whole row is selected. 

@ BHA Description. The bottom-hole assembly is described in these boxes. Specific labels change 

depending on the analysis option selected (logging, drilling, or packer operation). 

@ CT Database. If any properties of the coiled-tubing string are unknown, the user can access a large 

database of tubing properties. A pop-up window will request which database to load ("ctdb.db" is 
supplied with CTDRAG). The database can be edited and saved under the same or another name. A row 
of data can be imported into the C T  String Data Table by placing the cursor on the row and clicking 

[Export Data]. 
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@ CTString Display. The currently specified string of coiled tubing can be viewed (to relative scale) by 

clicking this button. A special window pops up that graphically displays the coiled-tubing outer radius 
and wall thickness along the entire string. 

@ Total Measured Depth. This value is derived from the survey data and is presented here for reference. 

a TotalString Length. The total length of the spool of coiled tubing and BHA is shown here for reference. 

3.2.5 Drag Parameters Page 

@ Wellbore Data Table. Properties for each section of the wellbore are specified in this table. Up to 20 

sections of casing, tubing, and open hole may be entered. A name andfor description of each section is 
entered in the first column (up to 60 characters). It is important that the sections are arranged in the 

correcl order; that is, the item at the top of !he list (row I )  is the casing a! the wellhead, and the remaining 
sections are in order descending down the wellbore. 

Techniques for entering and editing data in the table are summarized under Survey Page - O Survey Data 

Table in Section 3.2.3. 

@ Wellbore Data Table Control Buttom. The control buttons apply to complete rows of data. [Insert] 

places a new blank row above the cursor position. [Delete] clears data from one entire row, whether a 

single cell or the whole row is selected. 

@ Casing Data Base. ID of casing segments can be imported from the attached casing database. The file 

"csgdb.db" is installed with CTDRAG, and includes data on many varieties of casing. To import casing 
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ID into the Wellbore Data Table, click the [Casing Database] button, open the appropriate file, place the 
cursor in any cell on the row of interest and click [OK]. 

@ CTResidual Bend Coiled tubing is not completely straight as it emerges from the injector. Residual 

bends in the tubing can cause buckling to occur at lower axial loads than would be the case for perfectly 
straight tubing. The impact of residual bending can be simulated in CTDRAG by increasing the friction 
factor when running in the hole. Typical values for increases in friction factor due to this effect range up 
to about 0.05. 

@ Miscellaneous Drag Parameters. Other parameters that impact drag and the onset of buckling are entered 

in these boxes. Fluid densities and wireline weight (Cable Weight and Cable Diameter) change the 

effective weight of the coiled-tubing string. Stuffing Box Drag includes a drop-down list with three 
entries: nopressure, lowpressure and high pressure. These may be used as a starting point for estimating 

the additional injector force required to overcome drag across the stuffing box. C T  Yield Derating 
Factor is applied to the yield stress limit to specify the maximum axial load allowed in field operations 
to avoid yielding the tubing. A value of 80% of yield (0.80) is typical. 

@ Total Measured Depth. This value is derived from the survey data and is presented here for reference. 

@ TotalString Length. The total length of the spool of coiled tubing and BHA is shown here for reference. 

3.2.6 Input Window Menus 

The menu system used in CTDRAG is very similar to other Windows applications. Most functions are self- 
explanatory. There are five menus in the Input Windows of CTDRAG: File, Bun, output ,  Utility and Help. 

File Menu 

The File menu contains commands for creating, retrieving, saving and printing 
input data. Users familiar with earlier ME1 programs (including CDRAG) will 

notice a significant difference in file management with CTDRAG. Four or 
five files were used to store input data segregated by data type. In CTDRAG, 
all data are stored in a single file. (The single exception is the capability to 
importlexport data in the standard ME1 *.SDI file format. See Section 3.2.3.) 

Consequently, the File menu is simplified. The functions of the individual 
menu options are: 

1. "New File" clears all five input screens and displays a null project data 

file in the Model Window. 

2. "Open File ..." opens a dialog box for exploring the file system for input 
files with the extension ".cdl." This window functions as in other Windows applications. 

,- - 3. "Save File" replaces the previous version of the input data file with the current modified data. No prompt 
is given before overwriting the previous version of the file. 
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4. "Save File as ..." saves the current version of the input data under a different name. A dialog box is opened 

to let the user specify the drive, directory, and name of the project file. 

5 .  "Database" opens the GALAXY database interface window for importing/exporting data to other 

software. 

5 .  "Print File" prints a form displaying all current input data and parameters. 

6. "Exit" concludes the current session. CTDRAG will prompt for saving the project file if data have been 
changed and not yet saved. 

Run Menu 

The Bun menu is used to launch CTDRAG's calculations. Click "Start" after all 

input data are entered. CTDRAG will check for errors in the data (e.g., tubing wall 

greater than radius, etc.) prior to performing the calculations. The run icon a can 
, . 

also be used to launch the calculations. 

The Calculation Status Bar (located at the bottom of the Model Page) will display the progress of the 

calculation (from 0 to 100% complete). After the calculations are completed, the Output Window displaying 
the results will be loaded automatically. 

Output Menu ~ ~ I i ~ ~ ~ & ~ ~  .# ee:w.-rx-- v +i%. ~;i$;g$J * . . h ~ -  

1.. ,.a?-",i:($&.*.' ?PI( nE8 i ,.*. c,.z- 
The Output menu is used to switch from the input windows to the 

output results window. However, since this action is performed 1 
automatically after the calculations are launched, this menu does not normally need to be accessed. This 
command (and the corresponding icon ) is useful, however, when the user switches back to the Main H 
Window from the Output Window to review input data, and then wishes to return directly to the Output 

Window without recalculating. 

Utilitv Menu " 

The utility menu contains a command for selecting the system of units adopted for the 

input and output numeric boxes and graphs. Clicking "Units ..." opens the ...... 
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System of Units Selection Window 

@ Units Table. Physical parameters and currently assigned units for each quantity are displayed in the Units 

Table. The user cannot edit this table directly (indicated by the yellow background). Allowable options 
for each quantity are accessed by pulling down the drop-down box attached to each quantity. 

@ Custom Units Control Bunons. If any changes are made to the default English or SI systems of units by 

selecting another option from one or more of the pull-down boxes, the new custom system will need to 
be saved for future use. Use the [Save] button for new custom systems or updates to previously created 
systems. The [Save As ...I button is used when a new combination of units is designed, and the user wishes 
to save it separately, rather than overwriting the previous custom system. Both save buttons will cause 
a save dialog box to pop up. Custom systems of units are stored as *.UNT files. 

The [Print] button will print the System of Units Selection Table for documentation or reference. (This 
functions only after a save.) 

@ System of Units Selection Bunons. These buttons select entire systems of units, which then appear in the 

tabIe, and in all CTDRAG screens and graphs. The [Other] button will display the file names of the 
custom systems previously created and stored. 

The name of the currently selected system of units is displayed in the upper left comer of the System of 
Units Selection Window ("Default English" in the figure above). 

@ Numeric Display Format Table. The number of digits displayed for each parameter can be adjusted by 

the user. The number of zeroes after the decimal point for each quantity wiIl be used as standard for the 
input entries and for printouts. 
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Within the decimal section of the number (which defines how many decimals are displayed), a zero 

denotes a "hard" digit (always displayed) and a "#" denotes a "soft" digit (displayed if required). 

@ Control Buttons. These buttons control operations for the entire Units Selection window. [OK] accepts 

the current settings after any changes are made and then returns to the previous screen. [Cancel] ignores 
any changes made since this units screen was activated and returns to the previous screen. [Undo All] 
deletes all changes made since this units screen was activated, but stays in the Units window for further 

editing. 

Menu 

The Help menu provides information for obtaining additional assistance with 
CTDRAG and presents various parameters describing the user's computer. 

1. "Help Topics ..." launches the CTDRAG Help system. 

2. "Assistance ..." opens a pop-up box which displays MEl's address, phone 

number, e-mail address and other information. Use these contacts to obtain 
additional help with CTDRAG. 

3. "About ..." opens the About pop-up box, which displays the version number 
of CTDRAG along with hardware in the user's computer. 

4. "Feedback" opens a special screen form for documenting specific bugs, problems, etc. and communicating 
with MEI. The form can be printed for faxing or saved to disk and attached to an e-mail routed to 
mei@maureng.com 

3.3 ERROR DETECTION FOR INPUT DATA 

CTDRAG includes basic routines for detecting obvious errors in the input data. These routines are run as soon 

as the Run command is activated (under the Bun menu or run icon). When input data are outside the 
boundaries andlor appropriate range of values, the error-checking routines will often detect the error. The 
program will halt calculation, display an error message describing the problem, and allow the user to correct 

the problem. 

Obviously, CTDRAG is not capable of detecting small errors in the input data (i.e., when the incorrect 
parameters represent solutions that are physically reasonable), but the error checks will help prevent simple 
typing mistakes from having an enormous impact on the results. 

I f  no errors are detected, the entire calculation 
sequence is completed for the wellbore. A ~1 
calculation progress indicator is displayed at the w h c r h s  rhrldb~hlhnhkhrthe a*ck<~- : 
bottom of the Model Page. 

Oabu ad tDcw PaanmtuDatol 

. .  
. . 

After the calculation sequence is complete, the . . 
output windows are automatically loaded. 
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4.1 INTRODUCTION 

A great variety of output data is generated by CTDRAG for evaluation by the engineer. Output presentations 
include X-Y graphs and tables. The format of the printouts is very concise and informative. Printed output 
is ready for inserting into proposals, reports, etc. 

The tables present numeric values of all important force and drag parameters as functions of depth. The tables 
generally present the same data as the graphs, and the graphical format highlights trends and trouble spots for 
rapid evaluation and correction. Modifications to parameters can be rapidly implemented and tested by 
returning to the input screen, changing any parameter(s), and recalculating. 

4.2 OUTPUT WINDOW 

The Output Window of CTDRAG is loaded immediately after the calculation sequence is completed in the 
Input Window. The results of the drag and buckling analyses are presented in a variety of useful graphs, as 
well as in tabular format. Options are provided to view the graphs individually or in groups, to copy data to 
the Clipboard for importing into Word, Wordperfect, Excel, Powerpoint, etc., as well as several other 

convenient features. Windows in the output section of CTDRAG and all corresponding functions are 
described in turn in the following sections. 

- 
,- 4.2.1 Main Output Window 

The Oumut Window is the central navieatina point within the ournut section of CTDRAG. This window - -. 
/- >. appears fust after the calculations are completed. Six tiled windows will be displayed when the screen is first - 

loaded. 
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@ Menu Bar. The pull-down menus in CTDRAG output are used to modify output presentation, export 

data, select options for graph design, and several other useful functions. A description of functions and 
features of the output menus is presented later in this chapter in Section 4.2.4. 

@ ToolBar. Tool bar icons can be used to quickly access commonly used functions from the menus. The 

functions of CTDRAGTs output screen icons are: 

Print. Prints the currently focused (or maximized) graph or table. 

Copy to Clipboard. Exports the currently focused gaph  or table to the Clipboard in metafile 
format. From the Clipboard, the data can easily be pasted into other Windows applications. 

Sme,  Saves the currently focused graph or table to disk in metafile format. 

Main Window. Retums to the main Project Window (i.e., the Input Window) for reviewing 
and/or editing input data. 

Sensitiviw Analysis. Go to the Sensitivity Analysis window. (See Section 4.2.2.) 

Operation Animation. Go to the Operation Animation window. (See Section 4.2.3.) 

"2' r,x Help. Launches the CTDRAG Help System. 

Calculator. Pops up the Windows utility calculator. 

@ Graph and Table Windows. The output from CTDRAG is presented for evaluation in six tiled windows. 

These include: 

1. Axial LoadDistribution (Slack Ofl .  This is a snapshot of loads across the string when the BHA is 
at the bottom of the well and slack-off (compression) loads are being applied. Buckling conditions 
are easily visualized by noting sections of the string where the axial load crosses over limit curves. 
Curves that show yield loads (based on your safety factor) along the wellbore can be added to the .......................................... 
graph. Maximize the plot and click vsh ...... Y i l d  Limit; in the upper left comer of the graph. For ..................... .. ................ 
operations where the working loads are significantly less than the yieldlock-up limits, deselect this 
option so that details of the axial and buckling curves are much easier to view and compare. 

2. Axial LoadDistribution (Pick Up). This is a snapshot of loads across the string when the BHA is at 
the bottom of the well and pick-up (tension) loads are being applied. The exact condition shown is 
when the WOB just falls to zero. The tensile load limit of the string based on the chosen safety factor 

.............................................. 
can be added to the plot. Maximize the graph and click FGh Tensile Limit: in the upper left 

i ............................................ : 
comer of the plot. (Note that buckling cannot occur when the string is in tension.) 

3. Normal Force Distribution. Normal forces (the components of compression, tension and/or gravity 
forces that push the string against the side of the wellbore) are plotted as a snapshot when the BHA 
is at the bottom of the well. Traces for both slack off (the BHA has just arrived at the bottom of the 
hole with the required WOB) and pick up (at the point when the WOB just falls to zero) are plotted 

together. 
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4. Surface Load at Injector. This graph shows predicted push/pull loads at the bottom of the injector 
(above the stuffing box) throughout the planned operation. Results can be quickly evaluated to 
determine whether loads during the planned operation are near limits of the equipment. 

5. Inclination andDogleg Angle. The wellbore survey is illustrated with plots of both inclination angle 
(degrees from vertical) and dogleg angle (local rate of change of inclination). 

6. Tabulafed Results. All drag, buckling, force and wellbore survey results are summarized in a table. 
Columns include I) measured depth, 2) inclination, 3) azimuth, 4) dogleg angle, 5) hook load (slack 
off), 6) hook load (pick up), 7) sinusoidal buckling criterion, 8) helical buckling criterion, and 9) 
buckling condition (none, sinusoidal, or helical). 

@ Window ControlBunons. The standard Windows 95 control buttons can be very useful for maximizing 

and minimizing individual graphs for rapid review and evaluation of results. The button will enlarge 

a tiled graph or table to occupy the full screen. The ;"I button will minimize a graph or plot (i.e, 

convert it to an icon at the bottom of the screen). The button will temporarily turn off (close) a graph 

that is not of lnterest for a particular job operation. After closing one or more graphs, select "Tile" from 

the Window menu to redraw the screen with only the open plots (taking advantage of the increased space 

for each graph). Select "All" from the Window menu to redraw all graphs, including those previously 
closed. 

An additionalconvenient feature was added for rapidly reviewing the graphs. When in the tiled display 
format, double-click anywhere on a graph to maximize it. Review the plot, and double-click again to 

restore the tiled display. 

4.2.2 Sensitivity Analysis Window 

Axal Laad (Sbck-off) vs. Opm-Hole 
Friction Factor 

A n d  Load (P1ck.u~) vs Opm-Hole 
Fnctlon Faclm 

/ f o -04 )  / f o - o m  / f o - o m  I 
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The Sensitivity Analysis window is used for evaluating the effects of changes in several parameters (downhole 
friction factor, BHA drag, WOB, and wellhead pressure) on drag and buckling for coiled-tubing operations. 

This window is accessed by selecting "Sensitivity Analysis ..." under the Window menu or by clicking the 

icon. 

@ Sensitivig Tool-Bar Icons. Two icons are provided in the Sensitivity Analysis Window. 

Print. Prints the currently focused (or maximized) graph or table. 

Return. Closes the Sensitivity Analysis window and returns to the Output Window 

Calculator. Pops up the Windows utility calculator 

@ Sensitivig Analysis Parameters. Several parameters that impact axial and surface loads can be changed 

independently from within the sensitivity analysis. The friction factor entered for the open-hole 
environment will appear on the plots as the middle of three curves. Upper and lower bounds are also 
generated, based on friction factors 0.10 above and below the user-designated curve. The value entered 
for WOB will be used for the maximum x-axis value plotted in the Surface Load vs. Weight on Bit plot 
(upper right of window). 

@ Calculation Indicator. If any parameters are changed within this window, a new calculation must be 

performed to generate or refresh the plots. This calculation indicator applies only to this window; results 

in the main Output Window and parameters in the Input Window remain unchanged. 

@ Sensitivig Analysis Control Buttons. [Calculate] refreshes the calculation of the Sensitivity Analysis 

graphs and table. [Table] displays the results in a tabular format, which can be maximized, modified and 
printed. Press [Hide] on the table to return to the standard Sensitivity Analysis display. 

@ Sensitivily Analysh Graphs. Three special graphs are presented after each set of parameters is entered 

and the calculations are updated. These include: 

1. Surface Load versus WOB. Surface loads at the injector during drilling are compared for a range of 
friction factors. If the operation model is Logging (selected on Model Page), this plot is disabled 

since WOB is not applicable. If the model is Packer Operation, this plot will be entitled "Surface 
Load versus Packer Load." The maximum WOB displayed is based on the user's selection in the 

parameter boxes (see O above). 

2. Axial Load (Slack-Ofl versus Open-Hole Friction Factor. Local axial loads along the coiled-tubing 
string (assuming the BHA is at TD) are shown for slack-off (running into the hole). 

3 .  Axial Load (Pick-Up) versus Open-Hole Friction Factor. Local axial loads along the coiled-tubing 
string (assuming the BHA is at TD) are shown for pick-up (pulling out of the hole). 
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n - 4.2.3 Operation Animation Window 

The Operation Animation window is used to visualize and evaluate the development of buckling modes 

throughout the coiled-tubing operation. A second function in this window can be used to gauge the impact of 

increasing/decreasing weight on bottom. This window is accessed by selecting "Operation Animation...'' under 

the Window menu or by clicking the icon. 

@ Animation TooCBar Icons. Two icons are provided in the Operation Animation window. 

Return. Closes the Operation Animation window and returns to the Output Window. 

Calculator. Pops up the Windows utility calculator. 

@ Simulation Selection. Two types of simulations can be conducted in the Operation Animation window. 

Operation Animation will display a dynamic simulation of buckling conditions along the string as the 

coiled tubing is tripped into the wellbore. This simulation can be paused with the BHA anywhere along 

the wellbore. Bottom Load Variation is used to evaluate the impact of changes in the WOB (or weight 
on packer) on the buckling condition of the coiled-tubing string. This function can be used to determine 

how much reserve capacity for WOB is available before the string begins to yield (or equipment capacity 

is exceeded). 

@ Load Values. In the Operation Animation mode, three boxes display the current values for the surface 

load (injector load), depth of the BHA, and WOB. (These parameters cannot be edited directly while in 

Operation Animation mode.) In the Bottom Load Variation mode, surface load, bottom load (WOB), 

and weight increment (the increasetdecrease in WOB for every push of +/- buttons) are displayed. Bottom 

load and weight increment can be edited directly (as indicated by white background). 
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@ Sensitivity Analysis Control Buttons. The animated simulation of run-in-hole operations is controlled 

with these buttons. [Begin] clears the data from the graphs and begins the run in with the coiled tubing 
at the surface. [Pause] will halt the simulation at the current depth. [Continue] is used after a pause to 
restart the simulation at the same depth. [Stop] is used to end the simulation at any point. 

@ Axial Load Distribution. A special graph is displayed after each set of parameters is entered and the 

[Calculate] button is pressed. Axial loads and buckling criteria, all of which are updated as the simulation 
proceeds, are displayed for the coiled tubing up to its current depth of penetration. 

@ CTString Status. A wellbore schematic displays the approximate well profile with current coiled-tubing 

depth of penetration and buckling status for all sections of the string. 

4.2.4 Output Window Menus 

The menu system design used in CTDRAG is similar to other Windows applications. Many functions are self- 
explanatory. Several of the most commonly used menu functions can be easily accessed through the tool bar 
icons (see Section 4.2.1). There are five menus in the Output Window of CTDRAG: File, printer, Window, 
and Help. 

File Menu 

The File menu contains commands for printing, exporting, and saving output 
data. The functions of the individual menu options are: 

1. "Save Graph ..." opens a dialog box. The user specifies the drive, 
directory, and the name of the image file. The image of the graph is 
written to disk as a metafile (.WMF) or bitmap (.BMP). Select the Save 
File as Type in the Graph Save Window. 

2. "Save Table ..." opens a dialog box for saving the Tabulated Results. 

The user can specify the drive, directory, and the name of the image file 
(extension .out). The table is written to disk in ASCII format with 
comma delimiters. 

3. "Copy Graph" copies the focused graph to the Clipboard in metafile (.WMF) format 

4. "Print ..." leads to the options of "Graph", "Table", or "Both, and prints a high-quality image of the graph 
in the currently active graph window at the full resolution of the printer. CTDRAG also offers the option 
of printing in color. If a color printer is available, select "color" in the Printer menu. Printing in color 
on a monochrome printer will cause the printer to use gray scale instead of colors, and may not produce 

satisfactory results. 

5. "Return" is used to transfer back to the Main Project Window for reviewing or modifying input data. If, 
after reviewing the input screens, you wish to return to the output section without making any changes to 

the input data, select "Go to Output Window" from the Output menu or click the Icon. This saves 
time by not launching the calculation sequence if no data were changed. 

H' 
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1. "Monochrome" removes colors from the graphs and switches to line thickness variation to differentiate 

between each data trace for any subsequent print command. 

2. "Color" will send colored traces to the printer (with white background) 

Window Menu 

The Window menu contains commands for arranging the output 
graphs and tables on the screen. The first four options relate to the 
simultaneous display of all output (i.e., all non-minimized graphs and 

tables). 

1. "Cascade" arranges the graphs and tables in a Front to back 
display with the title block of each graph window remaining 
visible. The program adjusts the size of each open window to 
occupy the same amount of display space. The windows are then 
stacked starting from the upper left comer of the Output Window. 
Individual plots can be pulled to the top of the stack for viewing 
by clicking on their title blocks or by selecting them from the list 

(numbers 1 through 9) in the Window menu. 

2. "Tile" arranges the five output graphs and one table into hvo rows 
of three graphs each. This is the default arrangement when the 
Output Window is first loaded. 

3. "Arrange Icons" restores the alignment of your report and graph window icons (used in Windows 3.x). 

4. "All" and the six listed graphs and tables select the current output display. "All" shows all active plots 
simultaneously. Selecting an individual plot number has a different effect depending on the current 
display format. 

Ifthe output screen currently is. 

A full-size maximized graph 

A cascaded (stacked) display 

A tiled display 

Clicking a graph or table title 
will disploy that selection as.. . 

a A full-size maximized graph. 

e The top of the stack. 

a Unchanged, but with the focus moved. 

5. "Sensitivity Analysis ..." pulls up the Sensitivity Analysis Window for evaluating the impact of changes 
in downhole and BHA parameters on axial loads and buckling. (See Section 4.2.2.) 

,- 6.  "Operation Animation ..." pulls up a window for evaluating the dynamic development of buckling modes - throughout the coiled-tubing operation. A second function can be used to gauge the impact of 

increasingldecreasing weight on bonom. (See Section 4.2.3.) 
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Help Menu 

The Help menu provides information for obtaining additional assistance with 

CTDRAG and presents various parameters describing the user's computer. , + .i3 

I. "Help Topics ..." launches the CTDRAG Help system. 

2. "Assistance ..." opens a pop-up box which displays MEI's address, phone 
number, e-mail address and other information. Use these contacts to obtain additional help with 

CTDRAG. 

3 .  "About ..." opens the About pop-up box, which displays the version number of CTDRAG along with 

hardware in the user's computer. 

4.3 INTERPRETING OUTPUT DATA 

Drag and buckling predictions are very useful for planning coiled-tubing operations and avoiding problems 
in the field. The compressive loads required to initiate sinusoidal and helical buckling are indicated on the 

graphic output of the slack-off plots. The tubing yield limit is also shown. The significance of these stages 

of buckling is described below. 

Sinusoidal Buckling 
As compressive force is increased on a length of tubing lying along the bottom of an inclined hole, a point is 

reached where the tubing will assume a sinusoidal configuration side to side (basically a 2-dimensional shape) 
along the bottom of the hole. The critical force required to initiate this first mode of buckling is calculated in 

CTDRAG using one of three models selected by the user. Parameters that affect critical the sinusoidal 
buckling load include: 

A = Cross sectional area of tubing 
E = Young's modulus of tubing material 

g = Gravitational force 

I = Moment of inertia of tubing cross section 

r = Radial clearance between tubing and borehole 
p = Tubing density 

inc = Inclination of hole 

Helical Buckling 
Ifthe compressive load is increased beyond the point where sinusoidal buckling occurs, helical buckling will 
eventually be initiated. In helical buckling, the tubing forms a helix (spiral) along the wall of the hole (a 3- 
dimensional shape like a stretched spring). The pitch of the helix decreases as the compressive load increases. 
Helical buckling begins when the axial compressive force is about 1.4 times the value of the sinusoidaI critical 

load (based on the assumption of a straight hole). 
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F - Which Buckling Criterion Do I Use? 

As indicated above, the smallest critical force is the compressive load that initiates sinusoidal buckling. Next 
is the critical compressive force that shifts the tubing from sinusoidal to helical buckling. Finally, axial load 
increases to the point where the tubing begins to yield. What is the safe upper limitforjob planning? 

Field experience has been reported by several authors and participants in ME1 DEA projects. Newman et al. 
("Safely Exceeding the 'Critical Buckling Load' in Highly Deviated Holes," SPE 19229, 1989) indicate that 
coiled tubing can safely be pushed into a hole using compressive loads considerably in excess of the sinusoidal 
buckling threshold. In the field cases reported, compressive forces greater than the sinusoidal critical force 
have been used to push coiled tubing into inclined holes. Because of well geometry, they were not able to test 
compressive forces greater than the helical buckling critical force. It is their belief that compressive forces 
larger than the critical helical buckling force can safely be used to push coiled tubing into deviated holes, and 
many field operations conducted since then have verified this assumption. 

Logging operations by Canadian Fracmaster and Esso Resources Canada (Lohuis et al., 1991: "Coiled 

TubingiProduction Logging in Highly Deviated and Horizontal Wellbores," ClMiAOSTRA 9 1 - 15) in British 
Columbia have shown that coiled tubing can be safely subjected to buckling forces considerably above the 

- helical criterion, that is, about midway between the helical and "spring" limits (another yield criterion based 

on spring theory). Recent experience of at least one of the service companies indicates that the critical load 
calculated from spring theory is a reasonable indicator of the near upper limit of safe compressive forces to 

a use to insert coiled tubing into deviated holes. This force is considerably larger than the force required to 
h 

initiate helical buckling. It was also reported that when the spring buckling criterion was slightly exceeded, 
no damage to the tubing was observed 

The yield criterion is normally significantly higher than the helical buckling limit. This condition is closely 

associated with lock up. After the coiled tubing just begins to yield, significant additional force may be placed 
on the string before it fails completely, but little additional penetration will be achieved. The yield limit with 
an appropriate safety factor is a practical upper bound for tubing forces. The safety factor applied to the yield 
limit (on the Tubulars Page) is applied to the output graph and is based on practical experience. 

Buckling criteria should be used carefully and as guides rather than as absolute indicators. Judgment based 
on experience, though sometimes expensive to acquire, is of great value when dealing with such concepts as 
buckling and all its implications. Buckling itself does not imply failure, but it indicates the onset of a condition 

which may precipitate failure. 

Which Buckling Model Do I Use? 

Three different models for calculating sinusoidal and helical buckling loads are provided in CTDRAG. These 

include: 

Sinusoidal Buckling Helical Buckling 

- 1. DawsoniPaslay (Exxon) I. ChedCheatham (Rice University) 
2. WdJuvkam-Wold (Texas A&M) 2. WdJuvkam-Wold 
3. HeiKillingstad (Rogaland Research) 3. HeiKillingstad 

A 

A single model that has been accepted by several authors is used to calculate the load that begins to yield the 
coiled tubing. 
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From a historical perspective, the Dawson&"lay model was developed first and published in 1984. It quickly 
- 

became widely applied. ChedCheatham published their model for helical buckling in 1990. The other models 
were developed later (WdJuvkam-Wold and HeKillingstad were both published in 1993) and sought to 
examine and improve the assumptions and boundary conditions of the earlier models. 

There are two primary areas where these buckling models differ 

Straight Wellbores 
For straight wellbores (for example, horizontal sections), the primary difference between the models is the 
nature of the changing axial load in the interval between sinusoidal and helical buckling. The assumption made 
by ChentCheatham is that the axial load between the development of sinusoidal buckling and the onset of 

helical buckling is constant. Since the load does actually increase between these two buckling modes, 
ChedCheatham used a constant value that is the average axial load during the helical buckling process. 

WdJuvkam-Wold proposed that, rather than the average load, a linearly increasing load should be assumed 
for the helical buckling process. The result of this difference in assumptions is that WdJuvkam-Wold predicts 
a helical buckling load that is about 30% higher than ChedCheatham. Again, note that this applies for straight 
sections. 

The sinusoidal buckling load in a sfmight hole section is the same for all three models presented in CTDRAG. 

Curved Wellbores 
Buckling criteria in curved wellbore sections can be significantly different depending on the model selected. 
The primary difference between the models is the treatment of buckling in a curved section. Tubing that is 
constrained in a curved wellbore is already bowed and will be supported against the bottom side of the curve. 
Much greater axial loads are required in this case to force the tubing to lift off the bottom of the hole and 
buckle. DawsoniPaslay and ChedCheatham do not consider the impact of curvature on the development of 
buckling. 

Wu/Juvkam-Wold and HeKillingstad both consider the impact of wellbore curvature. Their analysis and 
experiments showed that, the larger the build rate, the larger the load to initiate buckling in curved wellbores 
with increasing inclination. WdJuvkam-Wold also model the increasing axial load between sinusoidal and 
helical buckling in curved wellbores, and consider the difference in length of the inner and outer curve of the 
casing. He/Killingstad assume a constant load (as did ChedCheatham) and ignore the length difference. 

Comparison of Models 

Due to the differences in these assumptions of axial loads and buckling in curved wellbores, the buckling 
models in CTDRAG can produce different results. This is especially hue for helical buckling in curved 
sections with increasing inclination (going to horizontal, etc.). Generally, ChedCheatham will produce the 
lowest (most conservative) helical buckling load criterion, HeKillingstad a higher load, and WdJuvkam-Wold 
the highest. In engineering analyses of this type, the engineer often tends to choose the most conservative 
model. However, since the constraining effect of a curved wellbore can be very significant, it is most probable 
that ChedCheatham is too conservative in these instances; that is, the string can be subjected to much higher 
loads without buckling helically. 

Beyond buckling issues, of course, is the question of yielding the coiled tubing. The same yield criterion is 
used for all three models. 
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5.1 CONTACTING ME1 

For additional assistance with installation or operation of CTDRAG, contact: 

1 
Dr. Roger Yan or Lee Chu 

MAURER ENGINEERING INC. 
2916 West T.C. Jester Boulevard 

Houston, Texas 77018-7098 U.S.A. 

Telephone: (713) 683-8227 
Fax: (713) 683-6418 

E-mail: mei@.maureng.com 

5.2 REPORTING PROBLEMS 

Even though CTDRAG 1.0 has been carefully checked before its release, software bugs are a fact of life. 
Please report any bugs you find and describe the input parameters and conditions selected when the bug 
occurred. Please check Appendix A fust to determine whether the solution to your problem is described there. 

ME1 is also very appreciative of your comments and suggestions for improving CTDRAG. Let us know if 
there are additional features you would like to see added to the program. Though it may not be feasible to 
incorporate every suggestion into the next version, many important improvements have been made to this and 
other ME1 programs based directly on suggestions from users. 

Please use the form on the next page to report bugs in the program, as well as suggestions on improving the 
function and usefulness of CTDRAG. 
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Bug ReportIEnhancement Suggestion Form 

Name: Company: 
Address: City: State: 
Phone No.: Fax No.: 
E-mail: Date: 

BugIProblem Report Enhancement Suggestion 

Program Name and Version Number: 

BugJProblem Description or Suggested Enhancement: 

- -- 
Other Comments: 

- 

p g  

Will be mailed on diskette Will be faxed Attached None 

Ooeratinv Svstem 
MS-DOS Version No.: MS-Windows Version No.: (Win 3.1lWin 95) 

OS2 MS-Windows NT Version No.: 
Other 

Please mail, fax, or e-mail to: 

Lee Chu 
MAURER ENGINEERING INC. 

2916 West T.C. Jester 
Houston, TX 77018-7098 

Ph: 7131683-8227 Fax: 7131683-6418 
11 E-mail: mei@maureng.com I I 
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Appendix A - Common Problems and Solutions 

Specific problems related to installing and running ME1 software are described in this section. These problems 

have been reported by multiple users and are often related to computer settings and file locations. 

A.l INTERNATIONAL KEYBOARD SETTINGS 

"Type Mismatch" Error 

All computer software developed at Maurer Engineering Inc. is written using the U.S. Keyboard format. Under 

this numeric standard, the 1000 separator is a comma, and the decimal separator is a period. Thus, the number 

one thousand, two hundred and thirty-four and 221100 is written as 

Numbers input into ME1 programs are stored in this format. 

Problems have occurred for some of our clients who use the International Keyboard format, as is common in 
certain countries in Europe and South America. Here, the same number would be written 

where the 1000 separator is a period, and the decimal separator is a comma 

Users with the International Keyboard format find that their computers garble input data being loaded into ME1 

programs. Often, a "Type Mismatch" error halts the program. 

This problem can be readily solved by changing the Windows numbers format from International to U.S. 
format. This can be accomplished as follows: 

In Window 3.x 

1. Select the "Control Panel" icon from the Main menu screen. This is done by pointing the mouse to this 

icon and double clicking. This brings up the "Control Panel" menu screen, as shown below. 
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2. Select the "International" icon from this menu screen by pointing to it with the mouse and double clicking. 
This brings up the International Menu screen. 

3.  In the lower right comer of the "International" menu screen is the "Number Format." If the number under 

the words "Number Format" is 1,234.22, ME1 programs should run successfully. Click <Cancel> to back 
out of this screen. 

If the number under the words "Number Format" is 1.234,22, it must be changed before ME1 programs 
will run successfully. 

4. To change the number format, click on the "Change" button in the "Number Format" box on the screen. 
This will bring up the "International-Number Format" screen. Change the "1000 Separator" from a 
decimal to a comma. Next, highlight the "Decimal Separator" box and erase the comma from the box and 
replace it with a period. 

2 .  Click <OK> to exit the "International -Number Format" box. Click <OK> to return to the Main menu 
screen. 

In Windows 95 

1. Select "Settings"+ "Control Panel" from under the Start menu. This brings up the "Control Panel" menu 
screen, as shown below. 

. ,, .., 
Display Find Fast Fonts t e n e t  ~ o y i k  

! . .:d 
@ LL- @ 4 0; ; 

Keyboard Mail and Fan Modems Mwse Multimedia k 

Network . Passwads Prirders 

2 .  DoubIe-click the "Regional Settings" icon. 
, % 

3.  The simplest method to change the number format is to select "English (United States)" from the drop- 
down list on the "Regional Settings" page. This changes all conventions to U.S. format. To change only 
the number format, click on the YNumber" tab and change the Decimal symbol to "." and the Digit 
grouping symbol to ",". You may have to restart your computer for these changes to take effect. 
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A.2 POTENTIAL LIBRARY FILE PROBLEMS 

Most of Maurer Engineering's computer programs are MS Windows-based programs which run under 
Windows 3.x. Windows 95> and Windows NT operating systems. When our Windows programs are run, 
several library files are needed (.VBX, .OCX, .DLL, and .EXE) to support the Windows interface functions. 
These library files might also be used by other Windows programs, which means all types of Windows 
applications theoretically can share the same library file from a "common library." 

The basic concept of a common library is sound. Since one library file may support many programs, storing 
the library once in an accessible location saves space on the hard drive. However, because of compatibility 
issues with different versions of the same library files, the wrong library version can cause a program error. 
Programs developed/compiled with older versions of librar)' files may not run with newer versions or vice 
versa. 

When running a Windows application, Windows searches for required library files in the following sequence: 

1. the \Windows\System\ subdirectory 
2. the \Windows\ subdirectory 
3. the local program subdirectory which contains the executable application .EXE file 

These rules were established by Microsoft and, unfortunately, may lead to serious problems. Placing the wrong 
version of the common library into \Windows\System\ subdirectory will cause all programs which use a 
different version of that library file(s) to malfunction. Maurer Engineering has received many reports of 
problems with our software after users have installed another company's software. These problems are the 
result of the third pa* software installing its own (different) version of the library into the \Windows\System\ 
subdirectory. This new version then gets priority over the correct version in the local ME1 subdirectory. 

All ME1 Windows programs install the requued library into the local program subdirectory to avotd contllct 
with other programs already installed. Though this method requires slightly more disk space be reserved for 
libraries. this is the safest approach. If thls procedure is followed, users should not be apprehensive about 
installing MEI's programs. 

If a user finds that an ME1 program will not run or the output graphs will not display, the following procedure 
should solve any library incompatibility problems. 

1. Most of the time, MEl's programs will display an error message to rndicate which library files are 
incompatible. If so, go to Step 4. 

2. Look at the specific program's subdirectory to find all the library files needed by the program. Usually, 
the library file extensions are .VBX, .OCX. .DLL, .EXE. 

3. Check the\Windows\System\ and \Windows\ subdirectories to seeif there is a different version of the 
library file (different size or different date) stored there. 

4.  Move these library files from the \Windows\System\ or \Windows\ subdirectories to a temporary 
subdirectory (do not erase these files) to determine whether library incompatibility is the problem. If 
these files are used by another (non-MEI) program, copy these files to the other program's subdirectory. 

The following library files most frequently cause problems: GRAPH.VBX, GSWDLL.DLL, GSW.EXE, 
GSWAG16,DLL, GSWI6.EXE, VBDB3OO.DLL, THREED.VBX, and GRID.VBX. 

If the problems persists after these steps are taken, please contact MEI. 
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A.3 PRINTER SELECTION 

ME1 programs support a wide range of monochrome and color printers. However, most programs winen in 
Visual Basic 3 (16-bit) do not provide options within the program for selecting individual printers. All print 
jobs are sent to the current Windows default printer. 

Changing Printers 

1f you wish to switch to a special printer, assign that printer as the Windows default printer before 
running the ME1 program. The default printer is selected under the Printers control window. This window 
is accessed in Windows 95 by selecting Star! -+ "Settings" -+ "Printers". After the Printers window is open, 
click once on the printer of interest to highlight it. Then, select "Set as Default" from the File menu. 

Network Printers 

Some users have experienced problems when trying to send output from ME1 s o h a r e  to network printers. 
Most difficulties can be addressed by modifying the printer port entry. If a nehvork printer wiU not print from 
an ME1 program, follow these steps: 

1. Select Start  -+ "Settings" + "Printers"; then double-click the network printer Icon 

2. Select "Properties" from the Printer menu. Select the "Details" tab from the Properties window (see 
figure). 

3. Place the cursor on the entry in the text box under Print to the following port:. Copy the text string by 
pressing control+C. 

4. Click the "Capture Printer Pon ..." bunon. 

5. Select "LPT2" or "LPT3" under the Device 
pull-down menu. 

6. Click the Path: text box; then paste the text 
string into the box by pressing contro[+V. 

Click <OK> to close the "Capture Printer 
Po< window. 

7. On the "Details" window. pull down the list 
of options under the Print to the following 

port: box. Select the new entry (that you 
just created) with "LPTZ" or "LPT3" 
followed by the text string copied and 
pasted. 

8. Select <OK> and close all printer windows. 

This procedure should allow printing to a 
network printer, provided that printer is also 
selected as the Windows default printer. 


